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OVERVIEW 
Zotero is a free bibliographic management extension that works with Firefox.  It recognizes 
websites and records in library catalogs and databases and is able to extract the bibliographic 
information associated with these sources.  In addition to its bibliographic capabilities, Zotero has 
several features that enable you to supplement your citation library including automatic capture of 
webpages, storage of files, images and links, as well as note taking and search abilities. Because 
Zotero works in your browser, it captures information as you do your research.  The advantage of 
this is twofold:  

 You can pull bibliographic information from multiple databases and import them into 
Endnote or Refworks in one step, without downloading text files and using import filters. 

 You can capture bibliographic information about many non-traditional sources such as 
webpages, wikis, and blogs. 

If you are already using software to help manage you citations, you may want to use Zotero in 
conjunction with other programs like Endnote or RefWorks. 

LIMITATIONS AND FUTURE PLANS FOR ZOTERO 
Because Zotero is a relatively new tool, it does not support some library catalogs and databases 
such as ISI Web of Science. By default, Zotero saves your library to the local machine – to 
transport your Zotero library, please see the Transporting Your Zotero Library section on page 4 
below. Its compatibility with Microsoft Word is somewhat limited.   

Zotero developers are addressing these issues, and its functionality is constantly being updated 
and improved.   Version 1.0 includes highlighting and annotation capabilities as well as an 
advanced search.  Beyond this, developers plan to add more translators, citation styles, 
import/export formats, web access to your Zotero library, and better integration with MS Word.  
For the latest information on Zotero’s features and limitations, visit 
http://www.zotero.org/documentation/known_issues_and_planned_features. 

INSTALLATION 
Firefox 2.0 is required for Zotero – you can download the latest version of Firefox from 
http://www.mozilla.com/en-US/firefox/. 

If you have FireFox 2.0 or higher, download the Zotero extension.  

1. Go to http://www.zotero.org and click on the red Download graphic. 

2. A dialog box will appear asking you if you would like to install your download.  Click on 
Install Now. 

CONFIGURING MGET IT 
You can configure Zotero to use MGet It, which allows you to find full-text of citations at UM.   

1. Click on the Actions icon ( ) menu and select Preferences. 

2. In the Resolver field under Open URL, enter the following link 
http://p9003-sfx.lib.umich.edu.proxy.lib.umich.edu/sfx_local 

http://www.zotero.org/documentation/known_issues_and_planned_features
http://www.mozilla.com/en-US/firefox/
http://www.zotero.org/
http://p9003-sfx.lib.umich.edu.proxy.lib.umich.edu/sfx_local
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GETTING STARTED IN ZOTERO 
You can start Zotero in four ways:  

 Go to the Tools menu and choose Zotero.  

 Click on the Zotero logo in the bottom right corner of your browser.                

 Click on the Zotero icon in your browser’s toolbar.       

 Press Ctrl + Alt + z if you are using a PC, or Shift + Apple + z on a Mac. 

 

To close Zotero, click on the Close window icon ( ) in the top right corner of the Zotero 
window, or repeat any of the four steps you used to open the Zotero window. 

THE ZOTERO LAYOUT 
To resize the Zotero window, click on the top edge of the window and dragging the edge to 
reposition the boundaries wherever you like. The Zotero window has three panels that represent 
different levels of specificity for your references. 

 The Left Panel shows your Zotero libraries and collections, as well as “tags” (keywords). 
The tags button is circled in the picture below. 

 The Middle Panel displays items contained within the library that you select in the Left 
Panel. 

 The Right Panel displays information about the item that you select in the Middle 
Panel. 

 

Left Panel                  Middle Panel   Right Panel 
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TRANSPORTING YOUR ZOTERO LIBRARY 
By default, your Zotero library is stored in Firefox on your computer.  You can change the 
location of the library to a portable drive (or your IFS space) or export the library. 

CHANGING THE LOCATION OF YOUR LIBRARY 
If you move around to several computers, you could change the location of your Zotero library 
on whichever machine you are at and access the same Zotero library. You would have to set this 
location on each computer. 

1. Quit Firefox, copy your Zotero library, and paste it in the new location (you could also 
drag it to a portable drive and that will make a copy). The Zotero folder is in your Firefox 
profile directory – see the Zotero FAQ to find the exact location 
(http://www.zotero.org/documentation/using_portable_firefox_on_a_usb_drive). 

2. Click on the Actions icon ( ) menu and select Preferences.  

3. Click on the Advanced tab. 

4. Click on the Custom radio button under Storage Location.  

5. A Select Zotero Data Directory window will appear. Once you select a directory for your 
library, Zotero will restart Firefox. All of your Zotero data will now be saved in the new 
directory.  

EXPORTING TO OTHER CITATION PROGRAMS 
To use your citations in Zotero on another computer or in a program such as EndNote, 

1. Click on the Actions icon ( ) menu and select Export.   

2. A dialog box will appear prompting you to choose the format of your exported document.  
Click on the Format pulldown list to select a format.  

3. If you plan to export your library into Zotero on another 
computer, choose Zotero RDF.  If you would like to export 
your library to another citation program such as Endnote or 
RefWorks, choose RIS.   

4. Click OK to save the file. You can now import the file into 
another citation program or into Zotero on a different 
computer (see the Importing from a Saved Zotero Library or other 
Citation Program section on page 6). 

http://www.zotero.org/documentation/using_portable_firefox_on_a_usb_drive
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ADDING CITATIONS YOUR ZOTERO LIBRARY 
You can add citations to your library in four ways: manually enter citation information, 
automatically cite webpages, import citation information for a single item, or import citation 
information for multiple items. 

 

Note: If you use EndNote, you need to change the default settings in Zotero so that you are not 
prevented from using Direct Export to EndNote features.  To do so, click on the Actions icon 

( ) in the Left Panel and choose Preferences.  Uncheck the box that says Use Zotero for 
downloading RIS/Refer files.    

CREATING CITATIONS MANUALLY 
To create a citation manually in your Zotero library, 

1. Go to the Middle Panel and click on the New Item icon ( ) 
menu. 

2. A pulldown menu will appear.  Select the type of source you would 
like to cite.  For more citations types, click on More and a full list 
of options will appear.   

3. In the Right Panel you will see fields specific to the type of source 
you selected.  Fill them in with the information for your item.   

CREATING CITATIONS FROM WEBPAGES 
To import citations for webpages into your library, 

1. In the Middle Panel, click on the Create New Item from the Current Page icon ( ).  
Information about the current webpage will automatically be pulled into your library.  

2. Edit the information by clicking on each field in the Right Panel.  

Zotero automatically saves the items that you import. This information, however, is saved only in 
your browser on your computer. When you cite a webpage, Zotero only pulls in the information 
available on the page – so if the author is not listed, you have to enter the name(s) manually.  

 

You can also add a link or take a picture of your current page that will be entered in your library as 
a citation. 

 Click on the Save Link to Current Page icon ( ) in the Middle Panel to cite a link. 

 Click on the Take Snapshot of Current Page icon ( ) in the Middle Panel to save a 
picture.  
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IMPORTING CITATIONS FROM DATABASES AND CATALOGS 
Zotero is compatible with many databases and library catalogs, including Mirlyn, Cambridge 
Scientific Abstracts, EBSCOhost, InfoTrac, JSTOR, LexisNexis, OCLC FirstSearch, ProQuest, 
and PubMed.  A full list of systems that Zotero supports can be found at the following URL: 
http://www.zotero.org/translators/. 

Once you have your search results, you can import multiple citations at the same time or choose 
just one individual citation. 

If you are on a page with a list of results, a Folder icon ( ) will 
appear in your address bar. If you are looking at an individual 

record, a Book icon ( ) or Article icon ( ) will appear instead. 
Click on the displayed icon. 

 If it is an individual record, it will immediately be added to 
your library.  

 If it is a result list, a box will appear with a list of all of the 
records so you can check the items you would like to 
import. Click OK and your items will appear in your library. 

 

IMPORTING FROM A SAVED ZOTERO LIBRARY OR OTHER CITATION PROGRAM 
To import from a saved Zotero library or another citation program,  

1. Export your citations from the other program and save as a RIS file. If you’re in Zotero, 
save it as a Zotero RDF (as described in the Exporting to Other Citation Programs section on 
page 4). 

2. Open your Zotero window. 

3. Click on the Actions icon ( ) menu and select Import. A dialog box will appear. 

4. Locate your saved document and click on Open.  

5. Your selected library (or file) will appear in the Left Panel in a separate folder.  

 

 

http://www.zotero.org/translators/
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SEARCHING FOR CITATIONS 
Once you have citations in your Zotero library, you need to be able to find specific records. There 
are two different kinds of searches: quick search and advanced search.  

QUICK SEARCH 
1. Click on the collection you would like to search in the Left Panel. 

2. Type your search term into the Search field in the Middle Panel. The field will search as 
you type. 

3. Results for your search will appear in the Middle Panel. These results will only be from 
the collection you selected in Step 1. 

SEARCHING WITH TAGS 
You can use the tags associated with the different items to find them. These can be the tags that 
you have created, or ones that were downloaded with the record from a library catalog or 
database.  

1. Make sure all the tags are showing by clicking the Actions button 

( ) in the Left Panel and choose Show Automatic. All the tags 
from selected collection are now displayed. 

2. Click on a tag, and you will only see items that have that tag. You 
can further narrow your search by clicking on additional tags. 

ADVANCED SEARCH  
You can also do an advanced search in a collection if you want your search to be more specific.  

1. Click on the collection you would like to search in the Left Panel. 

2. Click on the Advanced Search icon ( ) in the Middle Panel. A window will appear 
prompting your search with several different search capabilities. 

3. Choose a search category the Title pulldown menu on the left, and type in a corresponding 

search term. Add the search term by clicking the plus sign ( ) next to it.  

4. Continue this process until you have all the terms you would like to search for. You can 

delete search terms by clicking the minus sign ( ) next to them.  

5. Click Search. Results for your 
search will appear below. 

Note: You can save and name your 
search for future reference by clicking 
on Save Search and typing in a name. The 
search will be saved in the Left Panel. 
Any new items added to the library will 
be picked up automatically in these 
saved searches. 
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ORGANIZING YOUR LIBRARY WITH COLLECTIONS 
Zotero allows you to manage how your citations are organized.  You can change the locations of 
citations and the names of collections.   Additionally, you can add tags, links, and notes to 
individual citations to make them easier to search and identify. 

CREATING A NEW COLLECTION 
Within your Zotero library, you can create collections.  Collections are foldering tools to help you 
categorize your citations.  Your collections are shown in the Left Panel.  To add a new collection 
to your Zotero library, 

1. Click on the New Collection icon ( ) in the Left Panel. 

2. A box will appear on your screen prompting you to name 
your new collection. Choose a name and click OK.  Your new 
collection will appear in the Left Panel of the Zotero 
window. 

ADDING CITATIONS TO A COLLECTION 
If you would like to copy items from your library into your new collection,  

1. Click on the citations you would like to move in the Middle Panel. 

2. Drag the citation into the new collection in the Left Panel.  A copy will appear in the new 
collection.  This will not remove the item from its original location in your library. 

 

You can select multiple citations by holding down Control (PC) or Command (Mac) while you 
click. 

RENAMING COLLECTIONS 
If you would like to rename a collection, 

1. Click on the collection you would like to rename. 

2. Right-click (PC) or use Control + Click (Mac) on the highlighted item and select Rename 
Collection…. 

3. A dialog box will appear on your screen prompting for a new name. Type in the new 
name and click OK. 

DELETING CITATIONS 
To delete an item from a collection, select the item in the collection and press the Delete key on 
your keyboard. Note that this will only delete the item from the collection, and it will still be 
accessible in the library. If you do this from the library, you will permanently delete it.  

To delete an item from your library, select the item and right-click on it. Choose Delete 
Selected Item from Library. This will permanently delete the item along with any notes and 
relationships associated with it.  
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ENHANCING YOUR CITATIONS 

EDITING CITATIONS 
To edit information about items in your library,  

1. Click on the citation you would like to change in the Middle Panel. 

2. In the Right Panel, click on the field that you would like to change and type in your new 
information. 

ADDING ATTACHMENTS 
You can attach files to individual citations in your library.  This is useful when you have saved 
electronic versions (PDFs) of the articles that you are citing and would like to associate them with 
the corresponding citations.  To add an attachment, 

1. Select the citations to which you would like to attach your file in the Middle Panel.   

2. Click on the Attachments tab in the Right Panel. 

3. Click on the Add button.  A set of options will appear. 

4. You can either attach a file by choosing Link to File or by 
choosing Store Copy of File.  By linking to a file, you are 
creating a file path to the document stored on your computer.  If 
you choose to store a copy of the file, the entire document will be 
saved within Firefox. 

WORKING WITH TAGS 
Individual items can be tagged to facilitate searching and organizing. Items can have more than 
one tag. To add your own tag to a citation, 

1. Select the citation you would like to tag in the Middle Panel. 

2. Click on the Tags tab in the Right Panel, and then click on the Add button. 

3. Name your tag in the field that appears.  Your tag will then be attached to the selected 
reference and will appear as part of your tag list in the Left Panel.  If you click on the tag 
in the tag list, all citations with this tag will appear in the Middle Panel. 

Note: Some items saved from online catalogs will come with tags. To see these tags, click the 

Actions button ( ) in the Left Panel and choose Show Automatic. Now the tags (ones you’ve 
added as well as those that were already attached to the item) will display. 

ADDING RELATIONSHIPS 
You can also create a link between one item and another by adding a relationship between the two 
items. To add a relationship,  

1. Click on Related tab in the Right Panel. 

2. Click on the Add button. 

3. Select a citation to which you would like to relate the item and click OK. 



Getting Started with Zotero 
A University of Michigan Library Instructional Technology Workshop 

Need help? Visit the Faculty Exploratory or Knowledge Navigation Center on the 2nd floor of the Graduate Library. 

exploratory@umich.edu    |   http://www.lib.umich.edu/guides   |    knc-info@umich.edu 

rev: 5/21/08 

10 of 13 

CREATING NOTES 
To add a note to a citation, 

1. Select the citation you would like to add a note to in the Middle Panel. 

2. Click on the Notes tab in the Right Panel, then click on the Add button.  

3. A dialog box will appear into which you can type your 
note.  You can also add tags and related items to the 
citation you selected in this box by clicking on Related 
or Tags in the bottom of the frame.  

4. For articles without a link or snapshot, you can create 
multiple notes. For articles with a link or a snapshot, 
you are only allowed to create one note. 

To store a note independent of a citation in your library, click on the New Standalone Note icon 

( ) in the Middle Panel. A box will appear in the Right Panel for you to enter your note. 
When you are finished, the note will be saved with your references and will be accessible from the 
Middle Panel. The default name is the first few lines of text in the note.  

 

To create a note from a document or webpage that you are currently viewing, 

1. Highlight the text that you would like to cite. 

2. Right-click on the text to open the Options menu. 

3. Click on Create Zotero Item and Note from Selection.  Your text will be saved as a 
note for the citation of your current page. 

CREATING A BIBLIOGRAPHY  
To generate a bibliography, 

1. Select the items you would like to include in your bibliography in the Middle Panel. 

2. Once the items are highlighted, right-click on the 
selected items. 

3. Choose Create Bibliography from Selected 
Items.  A new dialog box will appear. 

4. Choose the citation style you would like to use for 
your bibliography from the pulldown list. 

5. Choose the format you would like save your 
document in, (Rich Text Format (RTF) or HTML 
for a webpage).  You can also choose to print the 
document. 

6. Click OK. 
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USING ZOTERO WITH WORD 
Zotero's plugin for Microsoft Word makes it easy to cite items from your Zotero library in Word 
documents. The plugin is available for both Mac OS X and Windows, and has been tested with 
various versions of Word. Further compatibility information and installation instructions are 
available online at http://www.zotero.org/documentation/microsoft_word_integration.  

Once you have installed the plugin, a new row of icons will be in your Microsoft Word toolbar. 

ADDING CITATIONS 
To add a new citation to your Word document,  

1. Click the Zotero Insert Citation ( ) button.  

2. If this is the first time you’ve added a citation to your current document, a Document 
Preferences dialog box will open. Choose the format you would like to use and click OK. 

3. An Add Citation window will appear. Select the 
item you would like to cite in your document. 

a. You can select multiple citations by 
clicking Multiple Sources… and adding 
sources to a list.  

b. Add page numbers as well as prefixes and 
suffixes in the appropriate boxes at the 
bottom of the window. 

4.  To preview your citation, click on the Show 
Editor… button. The Edit Citation box will 
appear at the bottom of the Add Citation 
window.   

5. Click OK. A properly formatting citation will now be in your document.  

EDITING CITATIONS 
To edit an already existing citation in your document, 

1. Click on the citation you would like to edit. Click the Edit Citation ( ) button.  

2. The Add Citation window will appear. Edit the citation as needed then click OK.   

GENERATING A BIBLIOGRAPHY 
To generate a bibliography from all of the items you have referenced in your document, click the 

Zotero Insert Bibliography ( ) button. A bibliography will be inserted at your current place in the 
document.  

http://www.zotero.org/documentation/microsoft_word_integration
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EDITING A BIBLIOGRAPHY 
To edit an already existing bibliography in your document,  

1. Click on the Zotero Edit Bibliography ( ) button. 
A window will appear containing your Zotero 
Library and the references currently in your 
bibliography.  

2. To add a reference to your bibliography, click on 
the reference you would like to add and append it 
to the list in the Right Panel.  

3. To edit references in your bibliography, click on 
the reference on the right you would like to edit. 
Edit it in the Edit Citation box below.   

4. Click OK when you are done. 

UPDATING REFERENCES AND PREFERENCES 

 If you have made any changes to your collection since inserting a citation or generating a 

bibliography, click the Zotero Refresh ( ) button. This will update your references in your 
document to any changes you have made.  

 To change the bibliographic style of your document, click the Document Preferences ( ) 
button. A window will appear allowing you to change citation styles and formatting. 
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USING A TIMELINE 
Zotero’s timeline function offers another way of visualizing your collections. 

To create a timeline,  

1. Select the items that you would like to be in your timeline.  

2. Click on the Actions icon ( ) menu and select Create Timeline. All of the selected 
items will be added to a timeline on the main screen of your browser.  

3. Each band represents a different historical magnification.  The lighter gray areas represent 
the area of the timeline currently visible on the first band. You can change the displayed 
time bands through the pulldown menus directly above your Zotero window. 

4. To view different parts of your timeline, click and hold anywhere in the gray area and drag 
left or right as appropriate. 

 

Clicking on an item in your timeline will bring up the corresponding item in your collection. For 
more information, please visit http://www.zotero.org/documentation/timeline_screencast. 

http://www.zotero.org/documentation/timeline_screencast
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